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BAB III 

METODE PENELITIAN 

 

3.1 Lokasi dan Waktu Penelitian 

 Penelitian ini penulis lakukan di Kota Cirebon, Provinsi Jawa Barat. Adapun 

alasan penulis mengambil lokasi ini karena daerah ini mengalami perubahan penutup 

lahan yang dapat mempengaruhi dampak distribusi suhu permukaan lahan yang ada di 

Kota Cirebon. Waktu penelitian pengaruh perubahan penutup lahan terhadap dampak 

distribusi suhu permukaan lahan ini dimulai dari tanggal 15 Mei 2019 – 15 Juli 2019 

karena dalam kurun waktu tersebut penulis mengumpulkan data dan mengolah data 

menjadi beberapa perubahan peta penutup lahan dan peta suhu permukaan lahan di 

Kota Cirebon, Provinsi Jawa Barat. 

Lokasi yang dilakukan oleh peneliti berletak di Kota Cirebon, Provinsi Jawa 

Barat. Letak geografis Kota Cirebon terletak pada posisi 108.33° - 108. 55° Bujur 

Timur dan 6.41° - 6.73° Lintang Selatan pada pantai Utara Pulau Jawa, bagian timur 

Jawa Barat, memanjang dari barat ke timur ±8 km, Utara Selatan ±11 km dengan 

ketinggian dari permukaan laut ±5 m dengan demikian Kota Cirebon merupakan 

daerah dataran rendah dengan luas wilayah administrasi ± 40,15 km² atau ± 4.015,3 ha 

yang mempunyai batas-batas: 

 Sebelah Utara : Sungai Kedung Pane 

 Sebelah Barat : Sungai Banjir Kanal / Kabupaten Cirebon 

 Sebelah Selatan : Sungai Kalijaga 

 Sebelah Timur : Laut Jawa 

Kota Cirebon memiliki lima kecamatan, yaitu Harjamukti, Kejaksan, Kesambi, 

Lemahwungkuk, dan Pekalipan. Adapun penjelasan seperti tabel dibawah ini: 

Tabel 3.1 Luasan Wilayah per-Kecamatan 

No Kecamatan Luas (ha) 

1 Harjamukti 1774.534696190 

2 Kejaksan 438.787137356 
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3 Kesambi 898.685797374 

4 Lemahwungkuk 741.775294438 

5 Pekalipan 161.553578058 

  Jumlah 4015.336503416 

Sumber : Hasil Perhitungan, 2019 

 

Kota Cirebon termasuk daerah iklim tropis, dengan suhu udara minimum rata-

rata 23,59 °C dan maksimun rata-rata 31,56 °C dan banyaknya curah hujan 1.194,7 mm 

per tahun dengan hari hujan 64 hari. Keadaan air tanah pada umumnya dipengaruhi 

oleh intrusi air laut, sehingga kebutuhan air bersih masyarakat untuk keperluan minum 

sebagian besar bersumber dari pasokan Perusahaan Daerah Air Minum (PDAM) Kota 

Cirebon yang sumber mata airnya berasal dari Kabupaten Kuningan. Sedangkan untuk 

keperluan lainnya sebagian besar diperoleh dari sumur dengan kedalaman antara dua 

meter sampai dengan enam meter, di samping itu ada beberapa daerah/wilayah kondisi 

air tanah relatif sangat rendah dan rasanya asin karena intrusi air laut dan tidak dapat 

digunakan untuk keperluan air minum.  

Kota Cirebon terdapat empat sungai yang tersebar merata di seluruh wilayah 

yaitu Sungai Kedung Pane, Sungai Sukalila, Sungai Kesunean (Kriyan) dan Sungai 

Kalijaga. Sungai berfungsi sebagai batas wilayah antara Kabupaten Cirebon dan 

sebagai saluran pembuangan air. 
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Gambar 3.1 Lokasi Penelitian 

 

 

3.2 Alat dan Bahan 

Alat dan bahan yang digunakan untuk pengaruh perubahan penutup lahan 

terhadap dampak distribusi suhu permukaan lahan di Kota Cirebon dijelaskan didalam 

tabel sebagai berikut: 

Tabel 3.2 Alat dan Bahan 

Alat dan Bahan Fungsi 

Laptop Lenovo spesifikasi Intel(R) 

Celeron(R) CPU N3060 processor 

@1.60 GHz, RAM 2 GB 

Untuk menganalisis data dan 

mengoperasikan software yang akan 

digunakan 

Software ENVI 4.5 Untuk mengolah citra satelit 

Software QuantumGIS 2.18.27 Untuk mengolah suhu permukaan lahan 

Software ArcGIS 10.3 Untuk pembuatan layout peta 
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Citra Landsat 5 yang diakuisikan pada 

03 Juli 2008 

Untuk pengolahan penutup lahan dan 

suhu permukaan lahan tahun 2008 

Citra Landsat 8 yang diakuisikan pada 

15 Juli 2018 

Untuk pengolahan penutup lahan dan 

suhu permukaan lahan tahun 2018 

Citra Sentinel yang diakuisikan pada 07 

April 2019 

Untuk base image pada saat koreksi 

geometrik 

Data Batas Administasi Kecamatan 

Kota Cirebon 

Sebagai batas administrasi Kota Cirebon 

Sumber : Hasil Penelitian, 2019 

 

3.3 Langkah Penelitian 

 Langkah penelitian merupakan tahapan kerja yang dilakukan penulis untuk 

mengetahui bagaimana cara mengumpulkan data, mengolah data dan menghasilkan 

output berupa peta. Adapun langkah-langkahnya sebagai berikut: 

1. Koreksi Geometrik 

Koreksi Geometrik dilakukan guna mengurangi kesalahan-kesalahan geometrik 

citra. Data Citra harus dikoreksi geometrik terhadap sistem koordinat bumi, supaya 

semua informasi yang berada pada data citra telah sesuai keberadaanya di bumi. 

Koreksi Geometrik dilakukan di wilayah Kota Cirebon pada citra landsat 5 dan citra 

landsat 8 dengan citra sentinel 2019. Adapun langkah-langkah sebagai berikut: 

1) Membuka software ENVI 4.5 dan memanggil data citra yang didalamnya terdapat 

Kota Cirebon 

2) Melakukan penggabungan seluruh citra landsat 5 dan citra landsat 8 dengan 

menggunakan layer stacking 

3) Menampilkan citra dengan RGB 321 pada citra landsat 5 dan RGB 432 pada citra 

landsat 8 di menu available band list 

4) Masukkan citra sentinel kedalam software Envi dan buka pada display 2. 

5) Pada toolbar utama, klik Map > Registration > Select GCPs: Image to Image 

6) Pilih display #2 yang menampilkan citra sentinel sebagai base image (citra yang 

digunakan sebagai acuan dalam melakukan koreksi geometrik), dan pilih display 
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#1 yang menampilkan citra Landsat 5 dan Landsat 8 sebagai warp image (citra 

yang akan dikoreksi geometrik) > OK 

7) Untuk melihat informasi GCP yang telah dipilih, klik Show List pada pada jendela 

Ground Control Points Selection 

8) Tentukan lagi GCP kedua dan seterusnya, sampai didapat minimal 8 buah titik 

GCP yang tersebar 

9) Pastikan nilai Nilai RMS Error harus di bawah 0,5 

10) Klik update agar citra menjadi terkoreksi geometrik. 

 

2. Koreksi Radiometrik 

Dalam pengolahan data citra visual diperlukannya koreksi radiometrik. Koreksi 

radiometrik dilakukan untuk memperbaiki nilai piksel dengan mempertimbangkan 

gangguan atsmosferik. Biasanya gangguan ini dapat berupa serapan, hamburan dan 

pantulan yang menyebabkan nilai piksel pada citra hasil perekaman tidak sesuai dengan 

nilai piksel pada objek sebenarnya di lapangan. Adapun langkah-langkah dalam 

melakukan koreksi radiometrik, sebagai berikut:  

1) Membuka metadata landsat 5 dan 8. Carilah nilai RADIANCE_MULT_BAND 

dan nilai RADIANCE_ADD_BAND untuk band 1-5 dan band 7 pada landsat 5 

dan untuk band 1-7 dan band 9 pada landsat 8. Catat dan ketik nilai-nilai tersebut 

di Tabel 3.1 dan Tabel 3.2, sesuai masing-masing band dengan nilai 

RADIAN_MULT_BAND diketik nilai ML dan nilai RADIANCE_ADD_BAND 

diketik di kolom Nilai AL  

Tabel 3.3 Konversi Nilai Radians 

Band Nilai ML Nilai AL Rumus Konversi ke Nilai Radians 

1 1.2538E-02 -62.68919 (1.2538E-02*float(b1)) -62.68919 

2 1.2839E-02 -64.19449 (1.2839E-02*float(b2)) -64.19449 

3 1.1831E-02 -59.15468 (1.1831E-02*float(b3)) -59.15468 

4 9.9765E-03 -49.88256 (9.9765E-03*float(b4)) -49.88256 

5 6.1051E-03 -30.52564 (6.1051E-03*float(b5)) -30.52564 
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6 1.5183E-03 -7.59145 (1.5183E-03*float(b6)) -7.59145 

7 5.1174E-04 -2.55872 (5.1174E-04*float(b7)) -2.55872 

9 2.3860E-03 -11.93011 (2.3860E-03*float(b9)) -11.93011 

Sumber : Metadata Citra Landsat 8, dan hasil perhitungan 

 

Tabel 3.4 Konversi Nilai Radians 

Band Nilai ML Nilai AL Rumus Konversi ke Nilai Radians 

1 7.6583E-01 -2.28583 (7.6583E-01*float(b1)) -2.28583 

2 1.4482E+00 -4.28819 (1.4482E+00*float(b2)) -4.28819 

3 1.0440E+00 -2.21398 (1.0440E+00*float(b3)) -2.21398 

4 8.7602E-01 -2.38602 (8.7602E-01*float(b4)) -2.38602 

5 1.2035E-01 -0.49035 (1.2035E-01*float(b5)) -0.49035 

7 6.5551E-02 -0.21555 (6.5551E-02*float(b7)) -0.21555 

Sumber : Metadata Citra Landsat 5, dan hasil perhitungan 

 

2) Mencari nilai REFLECTANCE_MULT_BAND dan 

REFLECTANCE_ADD_BAND untuk band 1-5 dan band 7 pada landsat 5 dan 

untuk band 1-7 dan band 9 pada landsat 8. Catat dan ketik nilai-nilai tersebut di 

Tabel 3.3 dan Tabel 3.4, sesuai masing-masing band. Dengan nilai 

REFLECTANCE_MULT_BAND diketik di kolom Nilai Mp dan nilai 

REFLECTANCE_ADD_BAND diketik di kolom Ap 

Tabel 3.5 Konversi Nilai Reflektan 

Band Nilai Mρ Nilai Aρ Rumus konversi ke nilai reflektansi 

1 2.0000E-05 -0.100000 (2.0000E-05*float(b1)) -0.100000 

2 2.0000E-05 -0.100000 (2.0000E-05*float(b2)) -0.100000 

3 2.0000E-05 -0.100000 (2.0000E-05*float(b3)) -0.100000 

4 2.0000E-05 -0.100000 (2.0000E-05*float(b4)) -0.100000 

5 2.0000E-05 -0.100000 (2.0000E-05*float(b5)) -0.100000 

6 2.0000E-05 -0.100000 (2.0000E-05*float(b6)) -0.100000 
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7 2.0000E-05 -0.100000 (2.0000E-05*float(b7)) -0.100000 

9 2.0000E-05 -0.100000 (2.0000E-05*float(b9)) -0.100000 

Sumber : Metadata Citra Landsat 8, dan hasil perhitungan 

 

Tabel 3.6 Konversi Nilai Reflektan 

Band Nilai ML Nilai AL Rumus Konversi ke Nilai Radians 

1 1.2793E-03 -0.003818 (1.2793E-03*float(b1)) -0.003818 

2 2.6736E-03 -0.007917 (2.6736E-03*float(b2)) -0.007917 

3 2.2753E-03 -0.004825 (2.2753E-03*float(b3)) -0.004825 

4 2.7539E-03 -0.007501 (2.7539E-03*float(b4)) -0.007501 

5 1.8647E-03 -0.007597 (1.8647E-03*float(b5)) -0.007597 

7 2.5884E-03 -0.008511 (2.5884E-03*float(b7)) -0.008511 

Sumber : Metadata Citra Landsat 5, dan hasil perhitungan 

 

3) Membuka Software Envi dan gunakan data citra Landsat 5 dan Lansat 8 yang sudah 

di koreksi Geometrik.  

4) Klik menu Basic Tools pada toolbar utama > Band Math. Di jendela Band Math 

tuliskan konversi ke nilai radians di kolom Enter an expression dan masukan rumus 

pada tabel 3.1, 3.2, 3.3 dan 3.4 

5) Setelah itu akan muncul jendela Variables to Bands Pairings > Klik pada tulisan B1 

– [undefined] > Kemudian di bawah tulisan Available band list, contoh Klik Band 1 

untuk rumus band 1  

6) Memilih/klik File pada menu Output Result to > klik Choose kemudian tentukan 

lokasi dan nama file output (Radians_Band1) > OK  

7) Melakukan hal yang serupa untuk mengkonversi nilai radian ke reflektan dengan 

rumus pada tabel 3.2 dan 3.4, pilih band pada Variables to Bands Pairings dengan 

menggunakan hasil Radian  

8) Setelah sudah dikonversi menjadi nilai reflektan, di layer stacking nilai reflektannya 

untuk melanjutkan proses resize citra dan cropping shapefile Kota Cirebon 
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3. Klasifikasi Supervised (Terselia) 

Pengolahan citra digital secara terselia atau supervised yaitu dengan membuat 

training area sampel per-kelas obyek yang dibuat oleh peneliti yang kemudian menjadi 

penentuan kelas penutup lahan. Adapun langkah-langkah klasifikasi secara terselia 

sebagai berikut : 

1) Membuka citra yang telah dilakukan proses koreksi geometrik dan koreksi 

radiometrik  

2) Membuka Citra Landsat yang telah dipotong/resize, tampilkan dengan komposit 

321 pada landsat 5 dan komposit 432 pada landsat 8  

3) Dari menu bar utama ENVI, Basic Tools > Region of Interest > ROI Tool  

4) Pemilihan ROI sebagai training area atau sampel untuk masing-masing penutup 

lahan sesuai skema Klasifikasi Penutup Lahan (SNI 7645:2014) dilakukan dengan 

ketentuan sebagai berikut:  

Landsat 5: 

 Jumlah lokasi training area per obyek = jumlah band yang digunakan +1 

{6+1 = 7 training area per kelas penutup lahan}  

 Jumlah piksel minimum yang diambil untuk setiap training area = (100*jumlah 

band)/ jumlah band+1 

{100*6)/7 = 85,7 piksel per training area  

Landsat 8: 

 Jumlah lokasi training area per obyek = jumlah band yang digunakan +1 

{8+1 = 9 training area per kelas penutup lahan}  

 Jumlah piksel minimum yang diambil untuk setiap training area = (100*jumlah 

band)/ jumlah band+1 

{100*8)/9 = 88,9 piksel per training area   

5) Memilih area sampel, misalnya Bangunan Campuran > Klik Window : Zoom 

ketika akan menentukan sampel ROI > klik kiri untuk memulai digitasi, dan klik 

kanan dua kali untuk menutup poligon ROI 
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6) Pastikan jumlah piksel lebih dari 86 buah pada landsat 5 dan 89 buah pada landsat 

8 > Kemudian ganti ROI Name menjadi Bangunan Campuran #1. Apabila jumlah 

piksel masih dibawah 86 buah/89 buah, hapus ROI dan ulangi digitasi.  

7) klik Window : Off saat selesai digitasi ROI > Klik New Region > Tentukan lokasi 

ROI selanjutnya, kemudian aktifkan kembali Window : Zoom. Lakukan kembali 

seperti langkah no 4 sampai 6, sampai didapatkan ROI per-training area untuk 

kelas penutup Bangunan Campuran. Buat ROI yang lokasinya tersebar  

8) Cek ROI dengan klik menu Tools pada jendela display > 2D scatter plot > Pilih 

band 3 (merah) sebagai parameter X dan band 4 (inframerah) sebagai parameter Y 

pada landsat 5; dan band 4 (merah) sebagai parameter X, dan band 5 (inframerah) 

sebagai parameter Y pada landsat 8 > OK.  

9) Setelah muncul jendela Scatter Plot > File > Import ROIs > pilih ROI_ Bangunan 

Campuran > OK.  

10) Lihat sampel yang kompak atau menyebar. apabila sampel menyebar maka 

silahkan diulangi pengambilan sampelnya. Apabila sampel sudah kompak 

(mengumpul). Simpan ROI permukiman yang telah dibuat dengan cara, klik File 

pada window ROI Tool > Save ROIs > pilih ROI yang akan disimpan > tentukan 

lokasi dan nama ROI (ROI_ Bangunan Campuran) dengan klik Choose. 

11) Setelah itu, gabungkan ROI per-training area dengan klik Option pada jendela ROI 

Tool > Merge Regions > pilih per training area permukiman> OK. Dan safe file 

tersebut dengan klik File > Save ROIs > tentukan lokasi dan nama (ROI_ 

Bangunan Campuran _merge)  

12) Lakukanlah langkah tersebut untuk setiap sampel penutup lahan 

13) Setelah itu, pada toolbar utama, pilih > Classification > Supervised > maximum 

likelihood > pilih input file > OK 

 

4. Merubah Data Raster menjadi Data Vektor 

Setelah melakukan klasifikasi terselia dengan metode Maximum Likelihood, data 

yang dihasilkan yaitu dalam bentuk file raster envi yang harus rubah kedalam data 
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vektor Shapefile agar dapat dilakukan perhitungan luas penutup lahan. Adapun 

langkah-langkah sebagai berikut :  

1) Buka Menu Classification > Post Classification > Classification to Vector  

2) Pada jendela Raster to Vector Input Band, pilih hasil klasifikasi yang akan 

dijadikan vector > OK 

3) Pada jendela Raster To Vector Parameters, Pilih kelas klasifikasi yang telah kita 

buat sebelumnya > OK 

4) Pada Jendela Available Vector List, Pilih RTV_nama klasifikasi dan kemudian 

pada jendela Available Vector List pilih menu file > Export Layer to Shapefile > 

OK.  

 

5. Menghitung Luas Penutup Lahan 

Menghitung luasan penutup lahan gunanya agar terlihat berapa luasan yang 

berubah, baik itu yang mengalami penambahan ataupun pengurangan. Adapun 

langkah-langkah untuk mengetahui luas penutup lahan pada interpretasi citra yang 

telah dibuat, sebagai berikut: 

1) Pada jendela Table of content, klik kanan pada layer data lalu pilih open attribute 

table.  

2) Pada Jendela Table, pilih Table Option lalu pilih add field.  

3) Pada jendela add field, tulis nama field Area_ha, Type data : Float, klik ok.  

4) Kemudian pada Attribute table, klik kanan pada field Area_ha, pilih calculate 

geometry, kemudian pada Property pilih Area unit Hectare(ha). 

5) Lakukanlah pemotongan citra dengan Georferencing, klik clip, dan masukan data 

hasil penelitian dengan batas kecamatan kawasan penelitian.  

6) Overlaykan data hasil klip dengan data administrasi desa kawasan penelitian 

dengan menggunakan tools union.  

7) Membuka data format file dbf pada software Microsoft Excel dan lakukanlah 

perhitungan dengan menggunakan tools privot untuk mengelompokan luasan kelas 

penutup berdasarkan kecamatan  
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6. Uji Akurasi 

Setelah melakukan klasifikasi, dilakukan uji akurasi untuk mengetahui akurasi 

citra yang telah peneliti buat yaitu dengan cara, sebagai berikut:  

1) Membuka data citra yang telah di interpretasi dan di klasifikasi pada software 

ArcMap 

2) Membuat data shapefile titik ground check sesuai klasifikasi penutup lahan dan 

aksesbilitas dengan jalan untuk memudahkan ground check.  

3) Untuk mengetahui koordinat yang telah kita digitasi di peta, membuat atribut X 

dan Y. Lalu open attribute dan pilih calculate geometri, pilih X pada atribut X dan 

Y untuk atribut Y.  

4) Meng-copy data tersebut kedalam excel dan print data tersebut.  

5) Melakukan ground check ke lapangan untuk mengetahui kesesuaian dengan data 

sampel koordinat yang telah di buat. 

6) Melakukan pengelompokan  

 

7. Pengolahan Land Surface Temperature 

Dalam pengolahan suhu permukaan lahan, penulis menggunakan aplikasi yang 

berbeda dengan sebelumnya, yaitu Aplikasi QuantumGIS. Dalam aplikasi ini bisa 

diketahui nilai minimum, rata-rata (mean), dan nilai maksimum yang nantinya nilai 

tersebut bisa digunakan untuk mengetahui suhu permukaan lahan. Metode yang 

digunakan pun sama seperti dengan metode Brigthness Temperature, yaitu nilai digital 

yang terdapat pada metadata diubah menjadi nilai radian lalu diubah lagi menjadi nilai 

Brigthness Temperature, namun pada aplikasi QuantumGIS ini dapat diubah menjadi 

Brigthness Temperature in Celcius. Adapun langkah-langkahnya sebagai berikut: 

1) Membuka software QuantumGIS 2.18.27 

2) Memanggil data shapefile Kota Cirebon pada layer panel dengan cara meng-klik 

Add Vector Layer > pilih shapefilenya 

3) Memanggil data raster band 6 pada landsat 5 dan band 10 pada landsat 8. Add 

Raster Layer > pilih band pada setiap landsat 
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4) Setelah data-data yang dibutuhkan terkumpul maka proses selanjutnya yaitu 

mengeklik Semi-Automatic Classification Plugin. Jika belum terdapat Semi-

Automatic Classification Plugin harus diaktifkan terlebih dahulu dengan syarat 

mengaktifkan internet dengan cara meng-klik Plugins > Manage and Install 

plugins > Search Semi-Automatic Classification Plugin > Install 

5) Setelah itu, klik Semi-Automatic Classification Plugin > Preprocessing > Landsat 

> Masukkan folder landsat 5 dan landsat 8 > Masukkan file MTL nya > Pilih band 

6 pada landsat 5 dan band 10 pada landsat 8 > Run 

6) Setelah itu, citra landsat harus dipotong/clip. Klik Raster > Extraction > Clipper > 

OK. 

7) Klik Raster Layer Statistic pada Processing Toolbox untuk mendapatkan nilai min, 

mean dan max > Input raster yang sudah di clipping > terdapat nilai min, mean 

dan max 

8) Catatlah nilai Min, Mean dan Max di Microsoft Excel dibuat tabel dan grafik 
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3.4 Diagram Alur Penelitian 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 3.2 Diagram Alur Penelitian  
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Keterangan Diagram Alur: 

1) Perolehan Data. Data yang digunakan yaitu berupa data Citra yang diunduh atau 

di download di website USGS Earth Explorer. Data yang diunduh berupa Data 

Citra Landsat 5 (tahun 2008) dan Citra Landsat 8 (tahun 2018). Selain Data Citra, 

ada pula data shapefile yang didapatkan dari instansi BAPPEDA (Badan 

Perencanaan Pembangunan Daerah) Provinsi Jawa Barat, contohnya Shapefile 

Administrasi, Kepadatan Penduduk dan lain sebagainya 

2) Proses Registrasi, Registrasi dilakukan untuk mengoreksi data citra. Ada dua 

proses registrasi yang dilakukan yaitu proses koreksi geometrik dan radiometrik. 

Koreksi geometrik dilakukan terhadap sistem koordinat bumi, supaya semua 

informasi yang berada pada data citra telah sesuai keberadaanya di bumi yang 

menjadi acuannya yaitu berupa citra sentinel menggunakan titik control atau GCP 

(Ground Control Point). Sedangkan koreksi radiometrik dilakukan untuk 

memperbaiki nilai piksel dengan mempertimbangkan gangguan atsmosferik 

dengan cara memasukan rumus-rumus band math yang tekah ada. 

3) Cropping Citra Terkoreksi. Hal ini dilakukan akan memudahkan dalam 

menginterpretasi citra agar tidak perlu menggunakan seluruh citra yang ada. 

4) Menentukan sampel dalam pemilihan kelas, pengambilan training area 

berdasarkan penutup lahan yang nantinya di klasifikasikan secara terselia atau 

Supervised. Metode klasifikasi dengan kemiripan maksimum (Maximum 

likelihood) dengan pemilihan sampel (contoh kelas) secara sengaja yang 

berdasarkan tampilan pada monitor dengan bantuan citra komposit yang telah 

dibuat. Pengambilan sampel dilakukan dengan poligon-poligon, yang setiap 

sampel diambil harus benar-benar homogen. 

5) Menggunakan band thermal, yaitu band 6 pada landsat 5 dan band 8 pada landsat 

8. Semi-Automatic Classification digunakan agar bisa menganalisis Suhu 

permukaan lahan menggunakan Raster Layer Statistic agar diketahui nila min, 

mean dan max dengan metode Brigthness Temperature 

6) Hasil pengaruh perubahan penutup lahan terhadap dampak distribusi suhu 

permukaan lahan kota Cirebon merupakan hasil akhir dari penelitian 


